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Creating Calendars for Tasks
in Microsoft Project 2000

Outlook’s Autocreate Feature

Microsoft Project schedules tasks using the working time
on the project calendar. If you have tasks to be completed
at different times, especially tasks that are independent of
resources, you may want to set up a “Task Calendar.”
Task Calendars are a new feature provided in Microsoft
Project 2000 that let you specify exceptions to working and
non-working time for individual tasks.

A Task Calendar is especially useful for situations in which
you want a task to be scheduled outside the normal
working times defined by the project calendar or assigned
resource calendars. For example, you can use task
calendars to define unique or specific exceptions for
individual tasks, such as machinery that runs during non-
working hours or machinery that requires maintenance
during working hours.

When you apply a specific Task Calendar to a task, these
new settings override the project calendar settings when
scheduling the task. If resources are assigned to the task,
the task is scheduled by the working times that the Task
Calendar and Resource Calendar have in common.
However, you can have the task ignore the settings in the
resource calendar by selecting the “Scheduling ignores
resource calendars” check box on the “Advanced” tab in
the “Task Information” dialog box.

Create a calendar for a task

1. Onthe Tools menu, click Change Working Time.
2. Click New.

3. In the Name box, type a name for your new
calendar.

4. To begin with a default calendar, click Create new
base calendar. To create a new base calendar
based on an existing calendar, click Make a copy
of, and then click the calendar name in the
calendar box.

5. Click OK.

B Continued on Page 2
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Users can “autocreate” a new Outlook item from an
existing one, and save on typing! Some examples include:

o Drag an e-mail message to the Task icon on the
Outlook bar, and create a Task with a due date.

« Drag a task to the Calendar icon to designate time to
work on the task.

+ In Calendar, select a task form the TaskPad. Instead
of dragging, highlight the task. In the Edit menu click
Copy or use the CTRL + C keyboard shortcut; click
on the date for the appointment and select the range
of time you would want to schedule the task for on the
Calendar (in Day mode) by clicking on the start time
and dragging the mouse to the end time. Click on
Paste in the Edit menu or use the CTRL + V shortcut
key. The appointment dialog box will appear. Fill in
the subject information, include a reminder setting if
you want, and save the appointment. The range of
time you selected for the appointment will be blocked
out for that day and the subject of the appointment will
be displayed in the box.

o Drag a contact to the Inbox icon to create a pre-
addressed message.

o Drag an Outlook note to the Inbox to create a
message with the content of the note already in it.

-- Angela Willingham, Training Manager
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6. Make the required changes to the calendar:
To change the calendar on specific days, select
the days you want to change on the calendar.
To select non-adjacent days, hold down CTRL,
and click the days. To select adjacent days, hold
down SHIFT, and click the first and last day for the
calendar change. To change a day of the week for
the entire calendar, click the abbreviation for the
day on the top row of the calendar.

7. Under Set selected date(s) to, click Use Default,
Non-working time, or Non-default working time.

8. To change Non-default working time, type the
times you want work to start in the From boxes
and the times you want work to end in the To
boxes.

Note: After you create a base calendar, you need to

assign that calendar to a task.
--Todd Samuel, Instructor
Todd is a Project Manager at Battelle Northwest and has been managing science

and engineering projects for over 12 years. He is a project management instructor
at City University’s Tri-Cities Site and PROTRAIN.SYS INC.
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“The Instructor was very willing to assist all level of students.
| am pleased with the experience.” - M. Stott

The Instructor has very good teaching skills.”
- S. Bardessono

“Very good Instructor, excellent course. | want more!”
- J. Mostoller

“Outstanding Instructor. Great pace — moved the class along.
Kept up the enthusiasm and kept us engaged in learning by
hands on training.” -J Morasch

Excellent, as always! Instructor is ready & willing to assist
those who need extra assistance. Superb and eager to assist
before, during, and after class. Instructor was very professional
and has a great sense of humor too. This is my third HTML
class with PROTRAIN, OUTSTANDING! | cannot wait to
return. WONDERFUL! The Instructor is so enthusiastic,
knowledgeable, and personable.” - C. Craighead

“Excellent communication skills”. - S. Heaton

Save Time with FrontPage
Components

When you have the same information on more than one
Web page that you need to update, there is no need to do
it manually on every page if you use FrontPage. Updating
each page individually can be very time consuming,
especially if your Web site has many pages. FrontPage has
a feature called Component Substitutions that makes it
easy to make periodic updates to all pages at one time.

Component Substitutions let you control parameter values
from a central location. FrontPage comes with some
parameters already created for you to use such as, Author,
Modified By, Description, Page URL, etc. The process to
create your own parameter values involves adding
parameters, such as your management/personnel names
and contact information or pricing. The parameters you
create have two inputs; the name of the parameter (a name
that is meaningful to you and describes the value) and the
value of the parameter. Then place the parameter name on
your web pages as desired. The value of the parameter
displays on your web pages, not the parameter name.

To create new parameters:

1. Select Tools and Web Settings... from the Menu
Bar.

2. Click on the Parameters Tab.

3. Select the Add... command button.
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-- “Save Time . . .” Continued from Page 2

4. Type a name in the Name: text box that describes the
value of the parameter.
5. Type the value of the parameter in the Value: text

box.
6. Click on OK twice.
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To add your parameters to your pages:

1. In FrontPage, open one of your web pages for editing.

2. Click on the page at the location you want to enter a
parameter value.

3. Select Insert, Component then Substitution... from
the Menu Bar.

4. Use the down arrow button in the Substitute with:
Combo Box to select the desired parameter or type in
the parameter name.

5. Click on OK and the parameter value should be on
your page.

6. Repeat this on every page you want parameter
information using the same parameter on different
pages or different parameters.

Substitution Properties Ed

Substitute with:
CompanyOwnerE mail j

When it is time to update information in your web that
exists as parameters just change the value of the
parameter and the change is effected at all of its locations.

1. Select Tools and Web Settings... from the Menu Bar.

2. Click on the Parameters Tab.

3. Select the component name you need to modify, and
then select the Modify... command button.

4. Type the new updated value of the parameter in the
Value: text box.

5. Click on OK twice.
6. All pages in your web that have that parameter value
will now have the new updated value.

You can update the stored parameters as needed and
have all the web pages with the inserted parameter
substitution change in one stroke. This Parameter
Component Substitution method of creating and updating
your web content can save a lot of time and money.

Note: If you are using earlier versions of FrontPage, the
Insert Menu feature name is FrontPage Component rather
than Component. Create and modify your parameters in
FrontPage Explorer and add them to your web pages in
FrontPage Editor.

-- Mike Gallagher, Primary Instructor
Technical Manager and Consultant

Affecting Text in Word

—The FONT option in the Format menu offers several ways
to affect text. See Effects section below.
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Select the text you wish to affect, choose FONT from the
FORMAT menu, click the desired box to activate the effect,
and click OK.

Check out the Text Effects tab. Have fun trying the
different effects.

-- Liz Houston, Instructor
Word Expert
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Creating Documents Using
Word’s Advanced Features

The decision to use MS Word is only the first step to
creating a document. Designing, formatting and printing are
the main steps that follow. If users create new Word
documents from scratch each time they create a letter or
report, they are not using the advanced features of Word
that can increase productivity. Here are some ways to
make things easier;

» Creating Documents as Templates

Generating documents can be simple by creating
templates. Standard text in documents should be saved as
a template. By doing so, documents can be produced
quickly and important information will not be inadvertently
left out of the document. Creating a template is as easy as
choosing Save As under the File menu and choosing the
Document Template type. Word templates can include
auto text entries, bookmarks, shortcut keys, styles, fields,
hyperlinks, sections, headers and footers, frames, toolbars,
menu bars, and more.

+ Table of Contents

In the past, creating a Table of Contents was a laborious
task. Now, with Word, this is largely an automated process.
The trick is to use styles in your document. By setting up
styles to format Heading 1, Heading 2, and so on, Word
can rely on this information to create an accurate Table of
Contents automatically.

e Footnotes

Footnotes help the reader locate and evaluate information
that supports a point made in the document.

» Hyperlinks

Hyperlinks allow users to easily jump to other parts of a
document, to open an entirely different document and even
jump to electronic documents on the Internet.

* Word Fields

A Word field is a special code that is used to insert
particular information such as page numbers, dates and
more. To insert a field in a document, choose Field in the
Insert menu.

Microsoft Word is a terrific report writer that developers can
use as a component of their application. Word can create
complex and elegant reports no matter what the source of
the data. Reports created in Word can be printed, sent by
email, or published on the Internet.

-- Liz Houston, Instructor
Word Expert

Join one of our
Advanced Word Courses
and increase your productivity!

MS Project TIP of the Month

Making Microsoft Project Data Available on the Internet

To support your efforts to communicate the status of
projects using the Internet, Microsoft Project can save
project files in Web (HTML) format. With the “Save as
HTML” command, you can easily convert information in
Microsoft Project to a format that can be published as a
document on the Internet. You can also attach image files
so that your charts will also display on the Internet, and any
hyperlinks in your file are automatically converted so that
they work in the new Web document as well. Also,
remember that you can create hyperlinks in your project file
that jump to documents on the Web, on your local network,
or on your own hard drive.

-- Todd Samuel, Project Manager at Battelle Northwest
and Adjunct Instructor at City University's Tri-Cities Site.

Internet Fundamentals $89
Word 2000 Upgrade $99

Excel 2000 Upgrade $99
(Register for both 2000 Upgrade classes for $179)

Intro to Crystal Reports $215

Crystal Reports Advanced $215
(Register both Crystal Report classes $398)

Classes are filling quickly

Call 946-1123 today!
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